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Quantitative cross-linking/mass spectrometry
to elucidate structural changes in proteins and
their complexes

Zhuo A. Chen"? and Juri Rappsilber ®"?*

Quantitative cross-linking/mass spectrometry (QCLMS/QXL-MS) probes structural changes of proteins in solution. This
method has revealed induced conformational changes, composition shifts in conformational ensembles and changes in
protein interactions. It illuminates different structural states of proteins or protein complexes by comparing which residue
pairs can be cross-linked in these states. Cross-links provide information about structural changes that may be
inaccessible by alternative technologies. Small local conformational changes affect relative abundances of nearby cross-
links, whereas larger conformational changes cause new cross-links to be formed. Distinguishing between minor and
major changes requires a robust analysis based on carefully selected replicates and, when using isotope-labeled cross-
linkers, replicated analysis with a permutated isotope-labeling scheme. A label-free workflow allows for application of a
wide range of cross-linking chemistries and enables parallel comparison of multiple conformations. In this protocol, we
demonstrate both label-free and isotope-labeled cross-linker-based workflows using the cross-linker bis(sulfosuccinimi-
dyl)suberate (BS3). The software XiSearch, developed by our group, is used to identify cross-linked residue pairs,
although the workflow is not limited to this search software. The open-access software Skyline is used for automated
quantitation. Note that additional manual correction greatly enhances quantitation accuracy. The protocol has been
applied to purified multi-protein complexes but is not necessarily limited to that level of sample complexity. Optimizing
the cross-linker/protein ratio and fractionating peptides increase the data density of quantified cross-links, and thus the
resolution of QCLMS. The entire procedure takes ~1-3 weeks.

Introduction

QCLMS/QXL-MS is a relatively new technique for studying the structural dynamics of proteins
and protein complexes. In cross-linking/mass spectrometry (CLMS/XL-MS) workflows, spatial
proximities between amino acid residues in protein chains are converted into covalent linkages via
cross-linkers, whereby the cross-linkers define maximal distance restraints between the cross-linked
residue pairs. The cross-linked peptide pairs are detected by MS and identified from fragmentation
patterns through database search. Data produced by CLMS provide information on protein folding,
topologies of protein complexes and protein-protein interactions' . In QCLMS, cross-links (cross-
linked residue pairs) obtained at different conformational states of a protein or a protein complex are
compared in a quantitative manner based on their MS signal. In general, structural rearrangements
are reflected as yield changes of cross-links, and locations of cross-links with major changes highlight
the structural regions that are changing.

The ability of QCLMS to reveal protein conformational change has been developed on a small set
of model systems’™''. Structural differences resulting in altered residue proximities, solvent accessi-
bility and relative steric position of residues have been observed to affect the formation and yield of
cross-links’. To date, QCLMS has been applied to reveal conformational changes of calreticulin'* and
Akt"’, induced by binding of Ca®" or different inhibitors. QCLMS has also been applied to reveal the
conformational change of the F,FoATPase resulting from phosphorylation'?, to study how con-
formations of the human Cull-Rbx1 complex differ when bound by Nedd8 and the deamidated
Nedd8 (ref. '°), to compare the conformational dynamic of eIF2 upon Met-tRNAM¢t bindingl(’; to
detect the impact of TBP binding on TAF11-TAF13 interaction'’; and to follow the final maturation
step of the 26S proteasome Lid complex'®. QCLMS was also used to reveal protein conformational
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dynamics of complement protein factor H in solution'’. In combination with crystallographic data,
QCLMS data were applied to generate a model for protein C3(H,0)*°. Moreover, QCLMS was used
to quantify changes in protein structures and interactions in living cells”"**.

As in standard quantitative proteomics, there are two major strategies for quantifying cross-links:
isotope labeling and label-free approaches. Thus far, isotope-labeling-based quantitation has
been applied only to pairwise comparison of protein conformations. One of the two protein
samples is labeled using heavy isotopes (e.g., *H, '*C, "N and '*0), and a 1:1 mixture of the two
protein samples is analyzed by MS. For each cross-linked peptide pair, the signals derived from
the two protein samples are distinguished by their mass and compared based on their signal
intensities. The isotope labeling can be placed on the peptides. For example, Huang et al."” applied
'80-labeling of peptides during digestion for quantitation of cross-links. After cross-linking,
one of two protein conformers was digested by trypsin in normal water, whereas the other was
digested in H,'®0, to add 8 Da, and the two were mixed before acquisition. Chavez et al. labeled
the peptides using stable isotope labeling by amino acids in cell culture (SILAC) in their QCLMS
study”'. An alternative strategy is to use isotope-labeled cross-linkers®’, whereby two different
conformational states of a protein/protein complex are cross-linked separately, using the non-labeled
and the heavy isotope-labeled analogs of a cross-linker. This cross-linking-specific strategy has been
applied in most QCLMS studies’™'*'»!*!>1820:2472¢ i luding the first protocol for QCLMS™.
Compared to a global peptide-labeling scheme, applying isotope-labeled cross-linkers labels only
cross-linker-containing peptides, minimizing the increase in sample complexity. However,
this approach requires pre-separation of different stable protein/protein complex conformers
before cross-linking. Furthermore, its application is also limited to cross-linkers available in isotope-
labeled forms.

By contrast, label-free quantitation tolerates any cross-linking chemistry. In label-free quantitation
workflows, protein samples of different structural conformations are not mixed at any step.
They are cross-linked, digested and analyzed by LC-MS/MS as separate samples but following
identical procedures. For a given cross-linked peptide pair of interest, abundance across the
set of samples is compared based on the signal intensities across individual MS acquisitions.
Therefore, label-free quantitation can more easily compare more than two protein samples.
Label-free quantitation does not necessarily require pre-separation of conformers before cross-link-
ing, as long as they can be resolved after cross-linking, for example as two separate bands on
SDS-PAGE. It has been successfully applied to reveal, in solution, the structural dynamic of the
complement factor H'".

Currently, the vast majority of reported QCLMS workflows use MS data acquired in data-
dependent acquisition (DDA) mode, with quantitation carried out using the extracted ion
chromatographic intensities of full scan (MS1) signals. However, quantifying cross-linked
peptides using a targeted MS approach has also been reported”>”®. In addition, Yu et al. applied
MS2-based quantitation to cross-linked peptides using tandem mass tags (TMT) in a proof-of-
principle study™.

To date, applications of QCLMS have been restricted to those pioneering labs that have been
developing QCLMS. A major reason preventing QCLMS from finding wider application is the lack of
quantitation tools. In the only published protocol, intensities of the light and heavy versions of cross-
linked peptides were obtained on the basis of extracted ion chromatograms (XICs) that were gen-
erated using XCalibur (Thermo Fisher Scientific). Using XCalibur, XICs of features of cross-linked
peptides have to be manually generated one by one. This process requires user expertise with regard
to mass spectrometric data and often involves subjective criteria that are hard to transfer accurately
between users. Furthermore, such manual quantitation is time consuming and becomes unma-
nageable when dealing with complex and large datasets. Great efforts have been put into automation
of QCLMS data processing. The software xTract® has been developed to quantify cross-linked pep-
tides identified using the xQuest/xProphet pipeline’”. Other solutions that are independent of
identification pipelines have focused on two directions: one aims to develop customized software
tools for quantifying cross-linking data such as XiQ”’; the other aims to exploit established quan-
titative proteomics software tools, some of which do not routinely accommodate cross-linking data,
for example, the vendor software Pinpoint (Thermo Fisher Scientific) and the open-source software
MaxQuant”’, Skyline’', MassChroQ’*>, mMass™ and pQuant™*. Applying these solutions to auto-
mation of data processing offers opportunities for a transferable QCLMS protocol, allowing for more
general application of QCLMS.
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Development of the protocol

Here, we describe a detailed QCLMS protocol. It offers options for label-free quantitation and
quantitation using isotope-labeled cross-linkers. Our protocol can be divided into five modules: pre-
experiment, quantitative cross-linking and sample preparation for LC-MS, LC-MS/MS data
acquisition, identification of cross-linked peptides, and quantitation of cross-links (Fig. 1).
The protocol provides full details on both experimental and computational setups established
in our group and utilizes a commonly used and commercially available cross-linker, BS3. This
protocol is aimed at users with little prior experience in CLMS. However, our protocol also
provides for great flexibility, with applications that use a wider range of cross-linking chemistry,
instrumentation setups and existing computational setups for identification of cross-linked
peptides.

We include the pre-experiment as a key procedure in the workflow. It is conducted to determine
optimal cross-linking conditions and decide on experimental procedures to be adopted for the
preparative QCLMS analysis (as discussed in more detail in the ‘Experimental design’ section).

Our workflow for quantitation using isotope-labeled cross-linkers (Fig. 1a) includes two new
procedures to improve the quantitation accuracy. First, we emphasize the need for replicated analysis
with a permutated isotope-labeling scheme. Our own benchmark study using this workflow indicates
that this procedure is essential for accurate quantitation’. Secondly, we introduce a strategy for
quantifying protein abundance of cross-linking products that uses the same computational pipeline as
is used for quantifying cross-linked peptides, offering a solution for adjusting the mixing ratio of
heavy-isotope-labeled and non-labeled samples.

In addition, we also describe a workflow for label-free quantitation35 (Fig. 1c). This opens QCLMS
analysis for a wider range of cross-linking chemistries. Label-free quantitation and quantitation using
isotope-labeled cross-linkers are not mutually exclusive. However, label-free quantitation allows for
more flexible experiments.

Strong cation exchange (SCX) chromatography-based fractionation is a commonly used strategy
for the enrichment of cross-linked peptides®®*’. In our benchmark study, we tested and confirmed
that SCX-based enrichment is fully compatible with our QCLMS workflow’, and it was included in
this protocol as an optional step with two options for handling different sample amounts and
complexities.

In QCLMS analysis, structural interpretation of the data is based on the quantitation of individual
cross-links. The mass spectrometric data are obtained from cross-linked peptide pairs. There are
usually multiple cross-linked peptide pairs supporting a linked residue pair. The quantified signal
change of a cross-linked residue pair is calculated as the median of the quantified signal change of all
its supporting peptide pairs, an operation similar to consolidation of data from peptides to proteins in
standard quantitative proteomics®®. This process may reduce the impact of outliers. However,
compared to proteins, cross-linked residues are on average supported by many fewer data points;
therefore, it is important to accurately quantify each cross-linked peptide pair and to be able to view
and validate the quantitation easily.

We have explored a few solutions for automated quantitation of cross-linking data. XiQ** and
MaxQuant (v.1.5.4.1 and higher)*> quantify cross-linking data in similar ways. They accept lists of
MS2 features of cross-linked peptide pairs (including identified m/z value, charge and retention time/
scan number of the identified MS2 events) as input. However, both software packages have two major
limits. First, quantitation using isotope-labeled cross-linkers requires cross-links to be quantified in
both replicates with a permutated isotope-labeling scheme, and signals of cross-linked peptide pairs
must be compared across the set of samples in label-free quantitation. Current versions of both XiQ
and MaxQuant do not support transfer of identifications of cross-linked peptides between MS runs,
which means only cross-linked peptides that are identified in all samples will be quantified. This fact
limits the coverage of quantified data. Second, neither software package provides an interface for
visualizing the quantitation results. xTract”, MassChroQ’?, Skyline’' and Pinpoint” support matching
of MS1 features of cross-linked peptides between MS runs through chromatography alignment, which
means that as long as a cross-linked peptide pair is identified in one of the samples, its signal can be
quantified across the whole set of samples. In addition, both Skyline and Pinpoint provide interfaces
for easy and fast visualization, validation and correction of quantitation results of individual cross-
linked peptides. In this protocol, we demonstrate Skyline because of its free availability and the
detailed user tutorials offered by its developers, which can be easily followed by users with little
experience (https://skyline.ms/wiki/home/software/Skyline/page.view?name=tutorial_ms1_filtering).
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Fig. 1| QCLMS workflows. a, The QCLMS workflow using isotope-labeled cross-linkers. In the pre-experiment, cross-linking titration is carried out for
each conformer, and an optimal protein/cross-linker ratio is determined (1). Next, conformer | and conformer Il are cross-linked with BS3 and BS3-d4,
respectively. The preparative quantitative cross-linking is repeated with a permutated isotope-labeling scheme (2). In each replicate, cross-linked
conformers are digested, and the peptides are mixed 1:1 based on starting material (A) or quantified relative protein abundance of the conformers (B).
The mixed peptides are fractionated using SCX chromatography (5) and analyzed by LC-MS/MS (6). Cross-linked peptides are identified (7) and
quantified using Skyline (8). The conformer Il/conformer | signal ratios of cross-links are summarized and are applied for structural interpretation (9).
b, Measured MST signals of a conformer I-unique cross-linked peptide, a conformer Il-unique cross-linked peptide and a cross-linked peptide yielded in
both conformers in the forward-labeled and the reverse-labeled replicates. ¢, The label-free QCLMS workflow. Application of the optimal cross-linking
conditions determined in the pre-experiment (1), conformers are cross-linked separately with BS3 in triplicate (2). Cross-linked conformers are then
digested by trypsin (3). Peptide mixtures are fractionated using SCX chromatography (4) and analyzed by LC-MS/MS (5). Cross-linked peptides are
identified (6) and quantified using Skyline (7). The signal intensities of cross-linked peptides are normalized based on protein abundance (8). The
relative signal intensities of cross-links are summarized and compared across conformers, leading to structural interpretation (9). Cl, Conformer I; ClI,

Conformer II.
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Fig. 2 | Linearization of cross-linked peptide sequences. a, A scheme for converting the sequence of a cross-linked peptide to a linear sequence with
identical mass. b, The scheme of mass calculation for the linearization of cross-linked peptide sequences. ¢, An example of conversion of the sequence
of a BS3 cross-linked peptide to a linear sequence for work in Skyline, applying the settings shown in b. Mod, modification. b adapted from ref. *> under
a Creative Commons Attribution 4.0 license (https://creativecommons.org/licenses/by/4.0/legalcode).

Skyline requires the sequences of peptides as part of the input for calculating the mass of the
peptides; however, it does not routinely accommodate cross-linked peptides. Similar to an approach
we previously used to identify cross-linked peptides, we established a strategy to convert the sequence
of a cross-linked peptide pair to a non-cross-linked linear form that has identical mass and retains
information on cross-linking sites®” (Fig. 2). This strategy is a general solution for software tools that
require peptide sequences for mass calculation but do not accept sequences of cross-linked peptide
pairs. Sequence linearization of cross-linked peptides can be carried out simply by using spreadsheet
applications such as Microsoft Excel before quantitation using Skyline. Subsequently, using linearized
sequences of cross-linked peptides, one can construct an input text file for Skyline using standard
Skyline format. Therefore, most existing computational setups for identification of cross-linked
peptides can be adapted to our QCLMS workflow with a single reformatting step (reformatting of the
identification list of cross-linked peptide pairs).

Applications of the protocol and limitations

Our workflow using isotope-labeled cross-linkers has been benchmarked by comparing the con-
formation of complement protein C3 and its active form, C3b’. The structural similarities and
differences concluded from QCLMS data agreed with what was revealed by comparing the crystal
structures of C3 and C3b, proving the reliability of our approach. We further compared the con-
formation of (C3(H,0)), another active form of C3, against C3 and C3b. Combining QCLMS data
and crystal structures of C3 gave rise to a detailed model of the structure of C3(H,0)*°. We also
applied this workflow to understand the structural mechanism behind the final maturation step of the
268 proteasome Lid complex (10 subunits)'®. Applying the label-free workflow, we quantified cross-
links from two monomeric cross-linking products of complement protein factor H, which revealed
the existence of two conformations'”. The label-free workflow also allowed us to reveal the con-
formational changes of the TAF11-TAF13 heterodimer upon its interaction with a third protein,
TBP". Cross-linking was achieved in this case using a UV-activatable amino acid analog that was
incorporated at engineered positions in the protein sequence.

When quantifying cross-linking data using Skyline, we manually inspect the peptide signal
selection and correct the peak isolation window, which improve the accuracy of quantitation results.
Although the processing time has been hugely reduced as compared to quantifying cross-linking data
manually (on average 20 s vs. ~5 min per cross-linked peptide pair), this procedure can still become a
limiting factor when working with datasets containing thousands of cross-linked peptides.
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More generally, the resolution of QCLMS for detecting protein conformational changes is limited
by the reaction time of the cross-linking chemistry applied, as well as by the density and distribution
of quantified cross-links. Combining QCLMS with high-density CLMS analysis may greatly improve
the resolution. However, conformational changes beyond the bridging range of the cross-linker would
still not be captured. For example, as a result of conformational rearrangement, the distance between
two residues changed from 60 A to 80 A; such a change would have not been detected by QCLMS
analysis using BS3, which has a cross-linking limit of 30 A.

Experimental design

Judging from the experience of proteomics technologies at large, there is no conceptual limit on the
complexity of protein samples to which QCLMS could be applied. Although this workflow has been
successfully applied only to purified proteins and multi-protein complexes, it is possible that it could
be adapted for the study of more complex systems, even the whole living cell. An important con-
sideration in the design of the experiment is to minimize the chances of measuring artifacts. Buffer
conditions must be chosen to keep proteins in their native conformation.

Our procedure uses the cross-linker BS3 (however, it is not restricted to BS3). BS3 contains an
amine-reactive N-hydroxysulfosuccinimide (NHS) ester at each end of an 8-carbon spacer arm. It
reacts with the N termini of polypeptide chains and the e-amine of lysine side chains. It can also react
with the hydroxyl groups in serine, threonine and tyrosine side chains. BS3 and DSS, which yield
identical products, are currently the most commonly used cross-linkers in CLMS studies. BS3 and its
deuterated analog, BS3-d4, are commercially available, so BS3 can be used in both label-free and
isotope-labeling-based quantitation.

Cross-linking, be it for identification of cross-links or for their quantitation, requires optimization
of the reaction conditions by performing a cross-linker titration (Supplementary Fig. 1). The proteins
are cross-linked in a series of increasing amounts of cross-linker, and the cross-linking products are
then separated using SDS-PAGE. This helps to determine an optimal protein/cross-linker ratio. It is
not sufficient to do this for one state of a protein. It may be the case that under identical cross-linking
conditions, two different conformations of a protein lead to different yields of cross-linking products;
for example, one may favor oligomerization (Supplementary Fig. 1c).

To improve the accuracy of quantitation, our workflow for isotope-labeling-based quantitation
includes replicated analysis with a permutated isotope-labeling scheme (i.e., if conformer I is cross-
linked with BS3 and conformer II is cross-linked with BS3-d4 in one sample, in its replica
with a permutated isotope-labeling scheme, conformer I is cross-linked with BS3-d4 and conformer II
is cross-linked with BS3. In both samples, cross-linked conformers are mixed at a 1:1 ratio,
allowing for comparison of signals of cross-linked peptides derived from the two conformers). The
characteristic signal shifts that result from a permutated isotope-labeling scheme provide con-
firmation of both identification and quantitation of cross-linked peptides (Fig. 1b): cross-linked
peptide pairs found in both conformers will be observed as doublet signals in both replicates, whereas
cross-linked peptide pairs that are unique to either conformer will be observed as singlet signals with
a mass shift of the mass of isotope labeling in the forward-labeled and the reverse-labeled
experiments.

By contrast, when applying label-free quantitation, each sample is treated and analyzed indivi-
dually, following identical procedures. Label-free quantitation does not require isotope-labeled cross-
linkers; therefore, it allows use of whatever cross-linker is most appropriate. In label-free
quantitation, signals of cross-linked peptide pairs are compared between sequential MS acquisi-
tions. To distinguish peptide signal changes derived from conformational differences from signal
variations between replicated analysis, generally three replicates are required for each conformational
state. Similar to using a 1:1 mixture of heavy and light labeled samples in isotope-labeling-based
quantitation, one should aim to use similar amounts of material from each conformer for LC-MS/MS
analysis.

The number of cross-links that can be identified and quantified greatly depends on the depth of
analysis. SCX-based chromatography can be applied to improve the depth of analysis by fractionating
peptides and enriching for cross-linked peptides in higher-salt fractions. SCX-based enrichment of
cross-linked peptides can be done either by HPLC or StageTip”’, depending on sample amount and
complexity. SCX-StageTip is suitable for a sample complexity in the range from 200 kDa to 1 MDa
and can be applied to a sample amount as low as a few micrograms. SCX-StageTips have limited
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capacities; the SCX-StageTip described in the Equipment setup should not be applied to fractionate
>50 ug of protein. HPLC requires a minimal sample amount in a range from 50 to 100 pg. It can be
applied to samples with low complexity (ranging from 200 kDa to 1 MDa); however, it is optimal for
high-complexity protein samples such as large protein complexes, as it offers more elaborated
fractionation. The quantitation module of this protocol requires LC-MS/MS data acquired using
the DDA mode and with high-resolution MS1 spectra. This specification leaves high flexibility
with regard to the LC-MS/MS setup and downstream computational pipelines for identification
of cross-linked peptides. In our setup, data detection is biased toward cross-linked peptides by
setting fragmentation only for ions with a charge of >3+4. When facing the choice of multiple
fragmentation modes, conclusions are based on their availability and respective merits'’. High-
resolution MS2 spectra provide high mass accuracy for fragment ions with determined charge
starts; these features improve accuracy of identification of cross-linked peptide pairs*'. Therefore,
we apply ‘high-high’ acquisition methods, generating both MS1 and MS2 spectra using an
Orbitrap mass analyzer. There are also computational pipelines optimized for using high-resolution
MS1 data and low-resolution MS2 (refs *“*?) data, MS3 (ref. **) data or multiple fragmentation
methods for each precursor*®. For accurate quantitation, one should balance the length of the DDA
cycle with the resolution of the chromatography system to ensure that a minimum of five data points
are recorded across the elution profile of each peptide. For example, a 3-s acquisition cycle would
allow for 10 data points for a peptide with a 30-s elution width.

Identification of cross-linked peptides is independent of quantitation using Skyline. In this pro-
tocol, we used XiSearch to identify cross-linked peptide pairs. Our group developed XiSearch, which
can be freely downloaded from https://github.com/Rappsilber-Laboratory/XiSearch. It has been
successfully applied in studies of large protein complexes’®*”. XiSearch does not rely on the use of
isotope labeled or cleavable cross-linkers for identifying cross-linked peptides. It can carry out
database searches for cross-linking data generated using different preparation workflows, including
different cross-linkers/cross-linking chemistries and digestion proteases. It is optimized for high-
resolution MS2 data; however, it can also handle low-resolution MS2 data. XiSearch is capable
of searching database sizes ranging from a few proteins to the whole proteome. Identification of
non-cross-linked linear peptides is included as part of the search results, which, in this protocol, are
used to determine the protein abundance for adjusting protein mixing ratios and normalization of
quantitation results.

However, our quantitation module is not restricted to the identification pipeline using XiSearch. In
the past decades, numerous software tools have become available for identification of cross-linked
peptides, for example, pLink*®, xQuest’>*’, Kojak"/, StavroX*’, MassMatrix*’, MeroX™’ and
XlinkX***'. Although many different CLMS workflows have been established and optimized using
software platforms, in most cases, the MS data are acquired in the data-dependent mode with high-
resolution MS1 spectra. Therefore, our quantitation procedure offers a generic solution for extending
many existing CLMS workflows for QCLMS. Note that when a pipeline requires the use of isotope-
labeled cross-linkers for identification of cross-linked peptides**™, it is incompatible with the
isotope-labeling-based workflow in our protocol.

To introduce cross-linking data into the full-scan filtering pipeline of Skyline, we devised a strategy
to linearize the sequence of cross-linked peptide pairs, Fig. 2a. The key element in this strategy is to
balance the equation such that the mass of the linearized sequence is identical to that of the cross-
linked peptide pair (Fig. 2b). This strategy can be applied to any cross-linker. The example in Fig. 2c
shows one way of doing this.

For quantitation purposes, all cross-linked peptide pairs identified from the conformers are listed
in a tab-delimited text file referred to as a .ssl (spectrum sequence list) file. The .ssl file includes the
sequence of peptides (in the form of linearized sequences), the MS file name, the scan number of the
matched MS2 spectrum, and the charge state of the identified cross-linked peptide pair. This
information allows Skyline to build a library of identified cross-linked peptides and track down their
signals in the mass spectra. The sequence and the identified charge state(s) are used to calculate the
‘m/Z value(s) of the cross-linked peptide pair, and the scan number of the matched MS2 spectrum
defines the retention time. An m/z value in combination with a retention time serves as a coordinate
for Skyline to identify the signal of a cross-linked peptide pair at a given charge state (often referred to
as a ‘feature’). The signal intensity of a feature is measured as the area of its chromatographic
peak. The signal intensity of a cross-linked peptide pair is the sum of signal intensities of all its
detected features.
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When quantifying using isotope-labeled cross-linkers, the identifications of both the light and the
heavy versions of each cross-linked peptide pair feature should be included in the input library. If one
of two versions of a feature is not identified, a pseudo identification entry is created, which adopts the
acquisition file name and identified MS/MS spectrum from its identified counterpart (Supplementary
Fig. 2). When quantifying in a label-free manner, the signal intensities of a cross-linked peptide pair
are compared between sequential MS acquisitions of different conformations of the protein sample.
Although an estimated equal sample amount should be used for LC-MS/MS analysis for each con-
former, it is necessary to normalize the signal intensities of cross-linked peptide pairs on the basis of
protein abundance is each sample.

In the end, quantitation readouts of cross-linked peptide pairs are summarized to cross-linked
residue pairs, the level of information required for drawing structural conclusions.

Materials

Reagents

General laboratory safety precautions should be taken when you are working with flammable, toxic

and corrosive substances. Work in a fume hood and wear appropriate gloves and safety goggles. Do

not inhale toxic vapors

e Acetic acid glacial (HPLC grade; Fisher Scientific, cat. no. A/0406/PB08) ! CAUTION Acetic acid is
flammable and corrosive.

e Acetonitrile (ACN; LC-MS grade; Fluka, cat. no. 34967) ! CAUTION ACN is flammable and toxic.

e Ammonium acetate (NH,HCO5; BioUltra; Sigma, cat. no. 09688) ! CAUTION Ammonium acetate is
toxic.

° Ammonium bicarbonate (ABC; ReagentPlus grade; Sigma-Aldrich, cat. no. A6141)

¢ Bis(sulfosuccinimidyl) 2,2,7,7-suberate-d4 (BS3-d4; Thermo Fisher Scientific, cat. no. 21595)
! CAUTION BS3-d4 is toxic.

¢ Bis(sulfosuccinimidyl)suberate (BS3; Thermo Fisher Scientific, cat. no. 21580) ! CAUTION BS3 is toxic.
A CRITICAL Cross-linkers with NHS-ester as a reactive group, including BS3 and BS3-d4, are subject
to hydrolysis, which inactivates the cross-linkers. Hence, such cross-linkers should be stored at 4 °C, in
a sealed vial. The vial must be equilibrated to room temperature (~23 °C) before opening to avoid
moisture condensation inside the vial. Solutions of these cross-linkers must be prepared immediately
before addition to protein samples.

e Coomassie staining solution (InstantBlue; Expedeon, cat. no. ISB1L) ! CAUTION InstantBlue causes
burns. Prevent inhalation and contact with skin or eyes.

¢ DTT (BioUltra; Sigma, cat. n0.43815) ! CAUTION DTT is toxic.

e Formic acid (FA; MS grade; Fluka, cat. n0.94318) ! CAUTION FA is corrosive.

¢ HEPES (BioPerformance Certified, 299.5% (titration), cell culture tested; Sigma, cat. no. 4034)

e Jodoacetamide (IAA; BioUltra; Sigma, cat. no. 11149) ! CAUTION IAA is toxic.

* LysC Protease (MS Grade, Thermo Fisher Scientific, cat. no. 90051)

* Methanol (LC-MS grade; Fluka, cat. no. 34966) ! CAUTION Methanol is flammable and toxic.

* Magnesium chloride hexahydrate (MgCI2-6H20, BioXtra grade, Sigma-Aldrich, cat. no. M2670)

e Sodium chloride, BioXtra grade (NaCl, BioXtra grade, Sigma-Aldrich, cat. no. S7653)

* PAGE gel (NuPAGE Bis-Tris precast gels; Thermo Fisher Scientific, cat. no. NP0321BOX)

® Phosphoric acid (BioUltra grade; Sigma-Aldrich, cat. no. 79617) ! CAUTION Phosphoric acid is
corrosive.

e Potassium chloride (KCl; BioXtra grade; Sigma-Aldrich, cat. no. P9333)

e Potassium hydroxide (KOH; BioXtra grade; Sigma-Aldrich, cat. no. P5958) ! CAUTION Potassium
hydroxide is corrosive.

e Potassium phosphate dibasic (K,HPO,; BioUltra; Sigma-Aldrich, cat. no. 60353)

® Reagents for gel electrophoresis (LDS sample buffer, MOPS SDS running buffer (20x), MES SDS
running buffer (20x); NuPAGE, cat. nos. NP0008, NP0001, NP0002, respectively)

e Trifluoroacetic acid (TFA; Sigma-Aldrich, cat. no. T6508) ! CAUTION TFA is corrosive and acutely
toxic; avoid contact with skin/eyes.

* Trypsin (MS grade; Thermo Fisher Scientific, cat. no. 90057)

* Urea (BioReagent grade; Sigma, cat. no. U5378)

e Water (LC/MS grade; Fisher, cat. no. W5-1)
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Equipment

® Gel electrophoresis chamber (XCell SureLock Mini-Cell electrophoresis system; Thermo Fisher
Scientific, cat. no. EI0001)

e Protein LoBind sample tubes (0.5 mL and 1.5 mL; Eppendorf, cat. nos. 022431064 and 022431081)

e Thermal mixer for 1.5-mL tubes (e.g., Eppendorf, ThermoMixer C model)

o Self-made C18 StageTips’”

o Self-made SCX StageTips™

¢ HPLC system (including injection valve, micro-flow pump, column oven, UV detector and auto-
collector; Dionex; Thermo Fisher Scientific, model no. Ultimate 3000)

e Polysulfoethyl A column (200 x 2.1 mm; 5 pm, 200 A; PolyLC, product no. 202SE0502)

e Javelin guard column (200 x 2.1 mm, 5 pm, 200 A; PolyLC, product no. J22GCSE0502)

*96-Well sample plate for LC-MS/MS injection (PCR microplate and silicone sealing mat; Axygen
Scientific)

¢ Vacuum centrifuge (Eppendorf, model no. Concentrator 5301)

¢ Mass spectrometer (Thermo Fisher Scientific, Orbitrap Fusion Lumos Tribrid model)

* LC system (Thermo Fisher Scientific, model no. Ultimate 3500-RS Nano)

* Easy-Spray ion source (Thermo Fisher Scientific)

e Easy-Spray C18 LC column (Thermo Fisher Scientific)

¢ 3M Empore C18 Extraction Disk (Fisher Scientific, cat. no. 14-386-2)

e Sep-Pak C18 cartridges (Waters)

* 3M Empore Cation Exchange-SR Extraction Disk (Fisher Scientific, cat. no. 14-378-104)

e Pipettes (0.1-2 pL, 1-10 pL, 2-20 pL, 20-200 pL, 100-1000 uL, Gilson)

e Scalpel (Cutfix disposable scalpels, Carl Roth, art. no. T988.1)

e Parafilm (Sigma-Aldrich, cat. no. P7668)

Software

 MSconvert; it is a part of the ProteoWizard Toolkit™ (http://proteowizard.sourceforge.net); v.3.0.10922
was used for developing and testing this protocol

e XiSearch (https://github.com/Rappsilber-Laboratory/XiSearch); v1.6.731 was used for developing and
testing this protocol

* XiFDR™ (https://github.com/Rappsilber-Laboratory/xiFDR), v.1.0.22 was used for developing and
testing this protocol

o Skyline®' (https://skyline.ms/project/home/software/Skyline/begin.view), v.3.7.0.11317 was used for
developing and testing this protocol

e Spreadsheet applications, e.g., Microsoft Excel (v.1997 or higher); Microsoft Excel 2013 was used for
developing and testing this protocol

PC hardware

Computer workstation with dual-core processor, 64-bit Microsoft Windows system (XP or newer
versions), and 4 GB of RAM would meet the minimum requirements for installation of all software
listed above. 4 GB of RAM enables database search using XiSearch against a database containing
megaDalton-size protein complexes.

Reagent setup

Protein samples

QCLMS has been mainly applied for analyzing isolated/enriched proteins and protein complexes;
however, proteins can also be analyzed in a complex protein background (e.g., in cell lysate). Stable
conformers to be compared must be separated before cross-linking. Samples should contain a
minimum of 30 pmol protein/protein complex of interest. More material is needed when fractio-
nation/enrichment of cross-linked peptide is applied (Procedure). The target proteins should be
cross-linked at a concentration of 0.5-1 pg/pL. The protein sample buffer should preserve the native
structure of target proteins and should be compatible with the cross-linking reaction (i.e., it should
have the correct pH and should not contain components that interfere with the cross-linking reac-
tion). An example sample buffer that is suitable for NHS-ester cross-linkers is described in the
following section.
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Cross-link buffer for NHS-ester cross-linkers

The cross-link buffer for NHS-ester cross-linkers is 20 mM HEPES-KOH, pH 7.8. To prepare 100 mL,
dissolve 0.48 g of HEPES in 90 mL of water; after adjusting to pH 7.8 using 1 M KOH, adjust the
final volume to 100 mL with water. Salts such as NaCl and MgCl, can be added to stabilize the protein
samples. Common additives for protein sample buffers, including 10 mM DTT, 1 mM EDTA, and up to
10% (vol/vol) glycerol, are compatible with NHS-ester-based cross-linking. Avoid buffer additives that react
with the cross-linker, ie., additives containing primary amines. Store at room temperature for up to 7 d.

50 mM Ammonium bicarbonate
To make 10 mL, dissolve 0.04 g of ABC in 10 mL of water. Store at room temperature for up to 7 d.

1 M DTT

To prepare 5 mL, dissolve 0.77 g of DTT in 5 mL of water. A CRITICAL DTT stock solution can be
affected by hydrolysis; prepared stock solution should be stored in small aliquots at —20 °C for no more
than 6 months.

Reduction buffer
Reduction buffer is 10 mM DTT in 50 mM ABC. To prepare 1 mL, dilute 10 pL of 1 M DTT in
50 mM ABC to a final volume of 1 mL. This buffer should be freshly prepared.

1 M Iodoacetamide

To prepare 5 mL, dissolve 0.92 g of TAA in 5 mL of water. A CRITICAL (IAA stock solution is sensitive
to light; prepared stock solution should be stored in the dark and in small aliquots at —20 °C for no
more than 6 months.

Alkylation buffer

Alkylation buffer is 55 mM IAA in 50 mM ABC. To prepare 1 mL, dilute 55 uL of 1 M IAA in 50 mM
ABC to a final volume of 1 mL. A CRITICAL Alkylation buffer is sensitive to light; it should be freshly
prepared and kept in the dark.

In-gel digestion buffer
In-gel digestion buffer is 45 mM ABC, 10% (vol/vol) ACN. To prepare 10 mL, mix 9 mL of 50 mM
ABC with 1 mL of ACN. This buffer should be freshly prepared.

LysC stock

LysC stock is 1 pg/pL LysC in 0.1% (vol/vol) TFA. Open a new vial containing 20 pg of LysC, and
dissolve LysC in 20 pL of 0.1% (vol/vol) TFA. LysC stock can be stored in small aliquots at —80 °C for
months. Do not thaw and refreeze LysC stock.

Trypsin stock

Trypsin stock is 1 pug/uL trypsin in 0.1% (vol/vol) TFA. Open a new vial containing 20 pg of trypsin,
and dissolve the trypsin in 20 uL of 0.1% (vol/vol) TFA. Trypsin stock can be stored in small aliquots
at —80 °C for months. Do not thaw and refreeze trypsin stock.

Denaturation buffer
Denaturation buffer is 8 M urea in 50 mM ABC. To prepare 10 mL, dissolve 4.80 g of urea in 50 mM
ABC to a final volume of 10 mL. This buffer should be freshly prepared.

10% (vol/vol) Trifluoroacetic acid
To prepare 10 mL of 10% (vol/vol) TFA, dilute 1 mL of TFA in water to a final volume of 10 mL.
Store at room temperature for up to 3 months.

0.1% (vol/vol) Trifluoroacetic acid
To prepare 10 mL of 0.1% (vol/vol) TFA, dilute 100 pL of 10% (vol/vol) TFA in water to a final
volume of 10 mL. Store at room temperature for up to 1 month.

80% (vol/vol) Acetonitrile
To prepare 10 mL of 80% (vol/vol) ACN, mix 8 mL of ACN with 2 mL of water. Store at room
temperature for up to 3 months.
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80% (vol/vol) Acetonitrile, 0.1% (vol/vol) trifluoroacetic acid (C18 StageTip eluent)

To prepare 10 mL of 80% (vol/vol) ACN, 0.1% (vol/vol) TFA, mix 8 mL of ACN with 100 pL of
10% (vol/vol) TFA and then dilute to a final volume of 10 mL with water. Store at room temperature
for up to 3 months.

10% (vol/vol) Phosphoric acid
To prepare 10 ml of 10% (vol/vol) phosphoric acid, dilute 1 mL of phosphoric acid in water to a final
volume of 10 mL. Store at room temperature for up to 3 months.

2.5% (vol/vol) Acetic acid
To prepare 100 mL of 2.5% (vol/vol) acetic acid, dilute 2.5 mL of glacial acetic acid in water to a final
volume of 100 mL. Store at room temperature for up to 14 d.

0.5% (vol/vol) Acetic acid
To prepare 10 mL of 0.5% (vol/vol) acetic acid, dilute 2 mL of 2.5% (vol/vol) acetic acid in water to a
final volume of 10 mL. Store at room temperature for up to 14 d.

0.5% (vol/vol) Acetic acid, 80% (vol/vol) acetonitrile
To prepare 10 mL of 0.5% (vol/vol) acetic acid, 80% (vol/vol) ACN, mix 2 mL of 2.5% (vol/vol) acetic
acid and 8 mL of ACN. Store at room temperature for up to 14 d.

1% (vol/vol) Acetic acid, 40% (vol/vol) acetonitrile
To prepare 50 mL of 1% (vol/vol) acetic acid, 40% (vol/vol) ACN, mix 20 mL of 2.5% (vol/vol) acetic
acid, 20 mL of ACN and 10 mL of water. Store at room temperature for up to 14 d.

0.5% (vol/vol) Acetic acid, 20% (vol/vol) acetonitrile
To prepare 20 mL of 0.5% (vol/vol) acetic acid, 20% (vol/vol) ACN, mix 10 mL of 1% (vol/vol) acetic
acid, 40% (vol/vol) ACN with 10 mL of water. Store at room temperature for up to 14 d.

2 M Ammonium acetate in water

To prepare 10 mL of 2 M ammonium acetate in water, dissolve 1.54 g of ammonium acetate in water
to a final volume of 10 mL. A CRITICAL 2 M Ammonium acetate should be freshly prepared and kept
in a refrigerator.

SCX StageTip elution buffer IV

SCX StageTip elution buffer IV is 1 M ammonium acetate in 0.5% (vol/vol) acetic acid, 20% (vol/vol)
ACN. To prepare 4 mL, mix 2 mL of 2 M ammonium acetate in water with 2 mL of 1% (vol/vol)
acetic acid, 40% (vol/vol) of ACN. Prepare freshly.

SCX StageTip elution buffer III

SCX StageTip elution buffer III is 200 mM ammonium acetate, 0.5% (vol/vol) acetic acid,
20% (vol/vol) ACN. To prepare 1 mL, dilute 200 uL of SCX StageTip elution buffer IV in 800 pL of
0.5% (vol/vol) acetic acid, 20% (vol/vol) ACN. Prepare freshly.

SCX StageTip elution buffer II

SCX StageTip elution buffer II is 100 mM ammonium acetate, 0.5% (vol/vol) acetic acid,
20% (vol/vol) ACN. To prepare 1 mL, dilute 100 pL of SCX StageTip elution buffer IV in 900 pL of
0.5% (vol/vol) acetic acid, 20% (vol/vol) ACN. Prepare freshly.

SCX StageTip elution buffer I

SCX StageTip elution buffer I is 50 mM ammonium acetate, 0.5% (vol/vol) acetic acid, 20% (vol/vol)
ACN. To prepare 1 mL, dilute 50 pL of SCX StageTip elution buffer IV in 950 pL of 0.5% (vol/vol)
acetic acid, 20% (vol/vol) ACN. Prepare freshly.

SCX off-line HPLC mobile phase A

SCX oft-line HPLC mobile phase A is 5 mM K,HPO,, 10% (vol/vol) ACN, pH 3.0. To prepare
1 L, dissolve 0.87 g of K,HPO, in 800 mL of water; add 100 mL of ACN, adjust to pH 3.0 with
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Table 1| Activation buffers for SCX-StageTips

Step Buffer Volume (pL)
1 Methanol 50
2 0.5% (vol/vol) Acetic acid, 80% (vol/vol) ACN 50
3 0.5% (vol/vol) Acetic acid 50
4 SCX StageTip elution buffer VI 50
5 0.5% (vol/vol) Acetic acid 50
6 0.5% (vol/vol) Acetic acid 50

10% (vol/vol) phosphoric acid and adjust the final volume to 1 L with water. Store at room
temperature for up to 14 d.

SCX off-line HPLC mobile phase B

SCX off-line HPLC mobile phase B is1 M KCl in 5 mM K,HPO,, 10% (vol/vol) ACN, pH 3.0. To
prepare 1 L, dissolve 74.55 g of KCl and 0.87 g of K,HPO, in 800 mL of water; add 100 mL of ACN,
adjust to pH 3.0 with 10% (vol/vol) phosphoric acid and adjust the final volume to 1 L with water.
Store at room temperature for up to 14 d.

LC-MS mobile phase A
LC-MS mobile phase A is 0.1% (vol/vol) FA in water. To prepare 50 mL, add 50 pL of FA to 50 mL of
water. Store at room temperature for up to 14 d.

LC-MS mobile phase B
LC-MS mobile phase B is 0.1% (vol/vol) FA in 80% (vol/vol) ACN. To prepare 50 mL, add 50 uL of
FA to 50 mL of 80% (vol/vol) ACN. Store at room temperature for up to 14 d.

Equipment setup
C18 StageTips
In this protocol, we use self-assembled C18 StageTips for desalting peptides. A detailed protocol for
making StageTips was reported by Rappsilber’”. A C18 StageTip is assembled using a C18 Empore
extraction disk in an ordinary pipette tip. StageTips can be assembled with multiple layers of Empore
extraction disks to increase the peptide-binding capacity. A C18 StageTip made with two layers of
1.2-mm-diameter discs has an estimated binding capacity of 50 pg. When the sample amount is
beyond the loading capacity, use several StageTips; alternatively, Sep-Pak C18 cartridges can be used
for desalting samples with large amounts and volumes.

Before loading peptides, C18 StageTips must be freshly activated by passing through 20 pL of
methanol and then 40 pL of 0.1% (vol/vol) TFA; they should not be allowed to dry out from that
point onward. Once dried, they must be activated again.

SCX StageTips

SCX StageTips are used for enrichment of cross-linked peptides in this protocol. They are assembled
using cation exchange-SR Empore extraction disks’”. An SCX StageTip made with three layers of
1.2-mm diameter discs has a binding capacity of ~50 pg. SCX StageTips must be activated by
sequentially passing through a series of buffers as listed in Table 1. StageTips should be freshly
activated before loading peptides and should not be allowed to dry out from that point onward.

SCX HPLC setup

Our offline SCX HPLC system for peptide fractionation is set up using a Dionex Ultimate 3000 HPLC
system. Peptide mixtures are fractionated using a polysulfoethyl A column (200 x 2.1 mm; 5 um,
200 A) connected to a guard column with the same packing material. The HPLC system is operated at
a flow rate of 200 pL/min, with a 30 °C separation temperature. Peptide samples are injected through
an injection valve. A curve gradient is applied with mobile phase B increasing from 0 to 70% over
18 min The gradient and the equation for the curved gradient are shown in Supplementary Fig. 3.
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Procedure

UV absorption at a wavelength of 214 nm is used for monitoring the separation. 200-uL fractions are
collected using an auto-collector.

The HPLC setup described here is not the only option; for example, Fritzsche et al.”” described
another solution for SCX fractionation of cross-linked samples.

LC-MS

The hardware of the LC-MS system used for QCLMS analysis follows the standard setup for bottom-
up proteomics. Users can choose from a wide range of commercially available HPLC instruments and
reversed-phase chromatographic columns that have been successfully applied in standard quantitative
proteomics studies. Efficient separation of complex peptide mixtures with good resolution and good
reproducibility in regard to peptide retention time are what to look for. We use an Ultimate 3500-RS
Nano LC system. Peptides are separated on a 50-cm Easy-Spray C18 LC column that is operated at a
50 °C column temperature. The eluted peptides are ionized by an Easy-Spray source. Normally, linear
gradients with increased amounts of organic solvent (most commonly ACN) are applied to elute the
peptides. The detailed recipe for the mobile phase may vary from user to user; recommendations are
often available from the manufacturers of the HPLC instruments and the reversed-phase columns. As
reference, gradients that are applied to separate complex protein samples (such as trypsin-digested
cell lysate) can be applied to cross-linking samples. Our mobile phase A consists of water and 0.1%
(vol/vol) FA, and our mobile phase B consists of 80% (vol/vol) ACN and 0.1% (vol/vol) FA. Peptides
are eluted at 0.3 uL/min using a linear gradient going from 2% mobile phase B to 40% mobile phase B
over 139 min, followed by a linear increase from 45% to 95% mobile phase B in 12 min. Using this
gradient, peptides are eluted in a 30-s elution window on average.

Schmidt et al.”” also described an example LC setup for QCLMS analysis. Another previous
protocol®” described an LC setup using a self-packed column for CLMS analysis. This setup offers a
more economical LC solution; however, we have noticed that a self-packed column may lead to lower
reproducibility in regard to peptide retention time.

Cross-linking not only substantially increases the complexity of the samples, but also dramatically
increases the chance of random match due to the quadratic search space. Measuring cross-linked
samples with high resolution and mass accuracy is essential to correct identification of cross-linked
peptides. On the other hand, fast scan speed and high sensitivity of the instrument are required to
detect low-stoichiometric cross-linked peptides. Mass spectrometers with Orbitrap mass analyzer
have become the most popular option for CLMS analysis; henceforth, in this protocol, we focus on
this type of instrument.

We optimized the MS acquisition methods for detection and downstream identification of cross-
linked peptides. In each DDA cycle, an MS1 scan is carried out in the Orbitrap instrument, and the m/z
values of peptide ions are measured. Then a few detected peptide ions are each isolated and fragmented.
The fragment (MS2) spectra are also recorded using the Orbitrap instrument. Ions with charge states
14 and 2+ are excluded from fragmentation to bias the detection toward cross-linked peptides, which
normally have a 23+ charge. With our LC setup, the duration of the acquisition cycle is controlled
within 3 s, allowing for 5-10 MS1 data points within the elution window for most peptides.

A good range of Orbitrap instruments can be and have been used for CLMS analysis. Supple-
mentary Table 1 lists the relevant instrument settings for CLMS analysis using different Orbitrap
mass spectrometers. Currently, the Orbitrap Fusion Lumos tribrid mass spectrometer is the most
preferred option because the sensitivity and scan speed of the instrument heavily influence the
outcome of the analysis, i.e., the number of detected/identified cross-linked peptides. Pre-enrichment
of cross-linked peptides is required for single proteins when using an early-generation LTQ-Orbitrap
instrument; however, it is not necessary for an instrument such as the QExactive mass spectrometer’.
The fast and sensitive Fusion Lumos mass spectrometer can efficiently detect cross-linked peptides
for large multi-protein complexes without any enrichment*’; when working with such an instrument,
enrichment can be left out for single proteins and small protein complexes of up to 300-kDa size.

Pre-experiment to establish the optimal protein/cross-linker ratio @ Timing ~8 h
A CRITICAL This procedure must be done for each conformer, unless conformers can be resolved only
after cross-linking or when comparing different cross-linking products of a protein.

NATURE PROTOCOLS | VOL 14 | JANUARY 2019|171-201| www.nature.com/nprot 183


www.nature.com/nprot

PROTOCOL NATURE PROTOCOLS

Table 2 | Commonly used cross-linking conditions

Cross-linking temperature Reaction time Quench time
37 °C 45 min 30 min
Room temperature (~23 °C) 1h 30 min
On ice (4 °C) 2h 30 min

Table 3 | A generic range for BS3 cross-linking titration

Protein/cross-  Protein Cross-linker Total
linker (pg:pg) volume (pL)
Amount Volume Concentration (pg/ Volume Amount
(ng) (pb) [118) (pb) (ng)
1:0 (Control) 2 n 0 1 0 n+1
1:0.25 2 n O15 1 0.5 n+1
1:0.5 2 n 1 1 0.15 n+1
11 2 n 2 1 2 n+1
1.2 2 n 4 1 4 n+1
1.4 2 n 8 1 8 n-+1
1:8 2 n 16 1 16 n+1

Choose initial starting conditions

1 Choose a cross-linking buffer that maintains the native fold of the proteins to be analyzed and at the
same time does not interfere with cross-linking. From the viewpoint of cross-linker stability, pH
must be considered, and additives that can react with the cross-linker should be avoided. A pH of
7.6-8.0 is optimal for NHS-ester-based cross-linkers such as BS3. Owing to the reactivity of such
cross-linkers, primary amines must be avoided, including standard buffers such as Tris. Ideally, the
cross-linking buffer is used during the last steps of protein purification, as this avoids the need for
buffer exchange. In the Reagent setup, we describe one generic recipe for a cross-linking buffer for
NHS-ester-based cross-linkers.
A CRITICAL STEP Avoid buffer additives that react with the cross-linker and control the pH.

2 Aim for a protein concentration between 0.5 and 1 pg/pL.
A CRITICAL STEP A low protein concentration reduces the reaction speed, increases the role of
cross-linker hydrolysis and often leads to additional enrichment steps after the reaction. A high
protein concentration increases the danger of protein aggregation.

3 Choose a temperature that maintains the structural stability of protein samples, e.g., 4 °C.
A CRITICAL STEP Temperature influences the reaction time. In our experience, 4-37 °C works well.

4 Choose a method for stopping the cross-linking reaction. According to the half-life of hydrolysis for
NHS-esters in aqueous buffers, cross-linking reaction times vary at different reaction temperatures.
Cross-linking is often stopped by adding reagents, such as ABC, that react with the cross-linker.
Table 2 lists three commonly used cross-linking conditions.

Titration of cross-linking reaction

5 To determine an optimal protein cross-/linker ratio, react small aliquots of protein sample in a
series with increasing amounts of cross-linker. A generic titration range for BS3 is listed in Table 3.
Following this experiment, add 1.4 pL of 2.5 M ABC to quench the reaction for each titration
sample (including the control).
A CRITICAL STEP The protein/cross-linker molar ratio can also be used for titration (Supple-
mentary Fig. la), especially when conformers have different numbers of subunits (e.g., when
comparing assembling intermediates).
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SDS-PAGE analysis of cross-linked proteins

6

Mix the quenched cross-linking reactions with loading buffer at a 7:3 (vol/vol) ratio and incubate at
75 °C for 5 min. The loading buffer should be freshly prepared before use by mixing NuPAGE LDS
sample buffer (4x) with 1 M DTT at a 5:1 (vol/vol) ratio.

A CRITICAL STEP Higher temperatures (up to 95 °C) can be applied to improve the efficiency of
protein denaturation; however, elevated temperatures can lead to the precipitation of hydrophobic
proteins.

Load the protein samples onto the NuPAGE 4-12% Tris-bis gel and separate the proteins with
a 100-V constant voltage using an XCell SureLock Mini-Cell Electrophoresis System with an
appropriate running buffer (such as MOPS SDS running buffer or MES SDS running buffer).

A CRITICAL STEP Low separation voltages require longer separation times; however, they may
reduce smearing artifacts.

Wash the gel with water for 5 min on a shaker. Repeat the wash three times. Stain the gel with
InstantBlue for 2 h on a shaker and de-stain with water for 2 h on a shaker.

A CRITICAL STEP One can also carry out SDS-PAGE using different setups. Silver stain can be
employed for visualizing low-abundant cross-linking products.

Optimal protein/cross-linker ratio

9

Choose the optimal protein/cross-linker ratio by inspecting the stained gel; it will be the ratio at which
the increasing yield of the desired cross-linking product reaches a plateau. For a protein complex, this
may be indicated by the disappearance of the bands of the individual subunits, which means all
subunits have cross-linked to at least one other subunit (Supplementary Fig. 1a). It is important to
choose reaction conditions that do not result in excessive cross-linking, e.g., that lead to oligomeric
complexes. This is harder to judge for protein samples that are made up of a single polypeptide chain.
The band of the cross-linked protein, as compared to that of the non-cross-linked protein (control), is
usually widened and shifts to a higher electrophoretic mobility. High yields of protein oligomers are
considered a sign of over-cross-linking, unless the protein can form homomers.

A CRITICAL STEP Avoid over-cross-linking, which will adversely affect the detection of cross-links
by MS.

? TROUBLESHOOTING

Preparative quantitative cross-linking @ Timing 6-8 h
10 There are two options, depending on whether you are using isotope-labeling-based quantitation

cross-linkers (option A) or label-free quantitation (option B). Isotope-labeling-based quantitation is
optimal for binary comparison and requires separation of conformers before cross-linking. Label-
free quantitation can be applied to compare multiple conformers. It can also be applied to compare
conformers that can be separated only after cross-linking or to compare different cross-linking
products of a protein sample.

(A) Preparative quantitative cross-linking using isotope-labeled cross-linkers

(i) Prepare fresh BS3 and BS3-d4 stock solutions (16 pg/pL BS3 prepared in the cross-link
buffer).

(ii) Cross-link conformer I with BS3 and cross-link conformer II with BS3-d4. Add cross-
linker from the stock or a diluted stock to the protein sample to reach the optimal protein/
cross-linker ratio determined in Step 9 and incubate as done during the pre-experiment.
A CRITICAL STEP Cross-linking conditions (including protein concentration, protein/
cross-linker ratio, reaction temperature and reaction time) must be identical for the two
comformers, i.e., for the BS3 and BS3-d4 cross-linking reactions.

(iii) Stop the cross-linking reactions by adding 2.5 M ABC with a 100x molar excess over the
added BS3/BS3-d4. The stop time should be the same as in Step 4.

(iv) Confirm the cross-linking reaction by visualizing the cross-linking products. Subject equal
amounts of cross-linked protein from each conformer to SDS-PAGE (Steps 6-8).

A CRITICAL STEP Only small aliquots of samples are needed, for example, the amount
used for the pre-experiment. Load cross-linked samples from different conformers side by
side for comparing yields of cross-linking products between conformers.

? TROUBLESHOOTING

(v) If multiple cross-link products form, for each conformer, separate the cross-linker products
using SDS-PAGE as described in Steps 6-8; this will allow for unambiguous interpretation
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of the identified cross-link sites. The isolated desired cross-link products are then in-gel
digested. Proceed to Step 11A. If only a single cross-link product forms, in-solution
digestion can be used (Step 11B). When cross-linking complex protein mixtures, it may
happen that cross-linking products do not appear as a single gel band; in such a case, in-
solution digestion or in-gel digestion of the complete gel (containing all cross-linking
products, not only the visible bands) should be carried out.

Repeat Step 10A(i-v); however; in Step 10A(ii), cross-link using reversed conformer—cross-
linker combinations (conformer I + BS3-d4, and conformer II + BS3).

A CRITICAL STEP Replicates with a permutated isotope-labeling scheme are essential for
subsequent data analysis.

(B) Preparative cross-linking for label-free quantitation

(i)
(ii)
(iii)

(iv)
v)

Divide each conformer sample into three aliquots.

Prepare a fresh BS3 stock solution (16 pg/uL BS3 prepared in the cross-linker buffer).
Add cross-linker from the stock or a diluted stock to each protein sample to reach the
optimal protein/cross-linker ratio determined in Step 9 and incubate as done during the
pre-experiment.

A CRITICAL STEP Cross-linking conditions (including protein concentration, protein/
cross-linker ratio, reaction temperature and reaction time) must be identical for all
comformers.

Stop the cross-linking reactions by adding 2.5 M ABC with a 100x molar excess over the
added BS3/BS3-d4. The stop time should be the same as in Step 4.

Visualize and isolate cross-linking products for digestion as described in Step 10A.

? TROUBLESHOOTING

Trypsin digestion of cross-linked protein sample @ Timing ~20 h)

A CRITICAL From Step 11 on, use only Protein LoBind sample tubes in all procedures, in order to
minimize the loss of cross-linked peptides.

Digest the samples by performing in-gel digestion (option A) when SDS-PAGE will be applied to
isolate the desired cross-linking product or in-solution digestion (option B) when SDS-PAGE
separation of cross-link products is not needed (e.g., a single cross-linking product forms or gel
filtration has been applied to separate the cross-linking products) or is not applicable (e.g., the
cross-linked protein complex is too big to enter SDS-PAGE or cross-linking products do not appear
as defined gel bands, especially when cross-linking a complex protein mixture).

(A) In-gel digestion

11

()
(ii)
(iii)

(vii)

Excise the protein band of the desired cross-link product from the gel using a scalpel.
Cut the gel band into 1-mm cubes and transfer them to a 1.5-mL sample tube.

Wash the gel pieces by adding 50 mM ABC. The volume of 50 mM ABC added should
cover all gel pieces. Incubate the gel pieces in a ThermoMixer at room temperature and
1,000-1,200 r.p.m. for 5 min. Add an equal volume of ACN. Incubate the gel pieces in a
ThermoMixer at room temperature and shake at 1,000-1,200 r.p.m. for 5 min. (Gel pieces
will shrink and turn white.) Remove the liquid by carefully pipetting it out.

Repeat Step (iii) three times.

Add reduction buffer to cover the gel pieces and incubate at 37 °C for 30 min. This will
reduce the disulfide bonds of the proteins. After incubation, remove the liquid by carefully
pipetting it out. Add ACN to cover the gel pieces. Incubate the gel pieces in a
ThermoMixer at room temperature and 1,000-1,200 r.p.m. for 5 min. Remove the liquid
by carefully pipetting it out.

A CRITICAL STEP Gel pieces will rehydrate and swell after addition of reduction buffer.
About 1.5x the volume added in Step 11A(iii) is needed (the same volume is needed in Step
11A(vi, vii, ix)).

Add alkylation buffer to cover the gel pieces and incubate at room temperature for 20 min
in the dark. This will alkylate the reduced cysteine residues. After incubation, remove the
liquid by carefully pipetting it out. Add ACN to cover the gel pieces. Incubate the gel pieces
in a ThermoMixer at room temperature and 1,000-1,200 r.p.m. for 5 min. Remove the
liquid by carefully pipetting it out.

Wash the gel pieces by adding 50 mM ABC to cover all gel pieces. Incubate the gel pieces in
a ThermoMixer at room temperature and 1,000-1,200 r.p.m. for 5 min. Remove the liquid
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by carefully pipetting it out. Then add ACN to cover the gel pieces. Incubate the gel pieces
in a ThermoMixer at room temperature and 1,000-1,200 r.p.m. for 5 min. Remove the
liquid by carefully pipetting it out.

(viii) Freshly prepare 10 ng/uL trypsin in in-gel digestion buffer. The trypsin solution should be
kept on ice.

(ix) Add trypsin solution to cover all gel pieces.

A CRITICAL STEP If the amount of trypsin added to the sample is a <1:50 (wt/wt) trypsin/
protein ratio, increase the concentration of trypsin digestion buffer until a 1:50 (wt/wt)
trypsin/protein ratio is reached.

(x) Incubate the gel pieces in a refrigerator for 10 min, allowing them to rehydrate. If
necessary, add additional volumes of trypsin digestion buffer to completely cover all
gel pieces.

(xi) Seal the sample tubes with Parafilm and incubate the gel pieces at 37 °C overnight (~15 h).

(xii) Collect the supernatant from the sample tube, and transfer it to a new sample tube as
extract L.

(xiii) Add twice the volume of 0.1% (vol/vol) TFA to extract I.

(xiv) Add ACN to cover all gel pieces. Incubate the gel pieces in the ThermoMixer at room
temperature and 1,000-1,200 r.p.m. for 15 min, allowing the gel pieces to shrink.

(xv) Collect the liquid from the sample tube and transfer it to a new tube, labeled as extract II.
A CRITICAL STEP Because the gel pieces shrink, the volume of extract II is larger than the
volume of ACN added in Step 11A(xiv).

(xvi) Remove the ACN from extract II, using vacuum centrifugation. The reduced volume from
extract II should be equal to or larger than the volume of ACN added in Step 11A(xiv).

(xvii) Add a one- to two-fold excess volume of 0.1% (vol/vol) TFA to the remaining extract II.

(xviii) Combine extract I and extract II and desalt the peptides using a Cl18 StageTip and
following the published protocol’”. When quantifying using isotope-labeled cross-linkers,
take an equal proportion of each cross-linked conformer (<10%, containing 0.1-1 pg of
protein), desalt it and store it on a separate Cl8 StageTip for quantifying protein
abundance.

A CRITICAL STEP Do not overload C18 StageTips. If the sample amount is beyond the

capacity of the StageTip (Equipment setup), use several StageTips.

? TROUBLESHOOTING

B PAUSE POINT Peptides can be stored on a C18 StageTip at —20 °C for multiple months.
(B) In-solution digestion

(i) Mix cross-linked protein sample with denaturation buffer at a 1:2 (vol/vol) ratio.

A CRITICAL STEP All steps are conducted at room temperature to reduce unwanted
derivatization of amino acid side-chains by the urea. Never heat your sample.

(ii) Add 1 M DTT to reach a 1:50 DTT/protein (wt/wt) ratio and incubate for 30 min. This will
reduce the disulfide bonds of the proteins.

(iii) Add 1 M IAA to reach a 1:50 TAA/protein (wt/wt) ratio and incubate the mixture in the
dark for 20 min. This will alkylate the reduced cysteine residues.

(iv) Add LysC stock to reach a 1:50 enzyme/protein (wt/wt) ratio and incubate for 3 h.

(v) Dilute the sample with 50 mM ABC to reach a 2 M urea concentration.

(vi) Add trypsin stock solution to reach an enzyme/protein (wt/wt) ratio between 1:100 and
1:50, and incubate overnight (~15 h).

(vii) Stop the digestion by acidifying the sample to pH <3 with 10% (vol/vol) TFA (test using
pH paper and drop-wise addition of 10% (vol/vol) TFA in a separate 1.5-mL tube
filled with the equivalent quantities of cross-link buffer and 50 mM ABC as used in
Step 11B(i-v)).

(viii) Desalt the peptides using a C18 StageTip and following the published protocol™. When
quantifying using isotope-labeled cross-linkers, take an equal proportion of each cross-
linked conformer (<10%, containing 0.1-1 pg protein), desalt and store on a separated C18
StageTip, in case the protein abundance needs to be quantified.

? TROUBLESHOOTING
B PAUSE POINT Peptides can be stored on a C18 StageTip at —20°C for multiple months.
12 For quantitation using isotope-labeled cross-linkers, the cross-linked conformer I and conformer II
need to be mixed in equal amounts. The cross-linked conformers can be mixed 1:1 based on the
amounts of starting material only if they definitely have the same yield of cross-linking product, i.e.,
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both conformers form a single cross-linking product (option A). Otherwise they should be mixed
on the basis of their protein abundance. Cross-linking often gives rise to heterogeneous products;
the actual yields of different cross-linking products for different conformers are unclear. Therefore,
a two-round quantitation (option B) should be carried out, first quantifying protein abundance of
the isolated cross-linked product for each conformer and then mixing the conformers according to
protein abundance and quantifying cross-linked peptides in a second round.
(A) Mixing the conformers on the basis of the starting material
(i) Elute peptides from C18 StageTips for BS3 cross-linked conformer I and BS3-d4 cross-
linked conformer II, each into a 0.5-mL sample tube. For each C18 StageTip, elute twice,
using 20 pL of C18 StageTip eluent (80% (vol/vol) ACN and 0.1% (vol/vol) TFA) each
time. If proceeding to SCX-based enrichment, elute using only 80% (vol/vol) ACN.
A CRITICAL STEP When dried down on a C18 StageTip, the peptides are eluted in two
steps: first, 1 pL of methanol is used to reactivate the stationary phase, and then 20 pL of
buffer containing 80% (vol/vol) ACN is used to elute the peptides. Collect and combine the
eluate from the two steps.
(ii) Mix the peptides from two conformers in equal amounts on the basis of the starting
material. Then proceed to Step 13 (optional) or Step 14A.
(iii) Repeat Step 12A(], ii) for the reverse-labeled replicate.
(B) Mixing conformers on the basis of determined protein abundance
(i) Elute the small aliquots of BS3 cross-linked conformer I and BS3-d4 cross-linked
conformer II that were reserved in Step 11A(xviii) from the C18 StageTips, each into a well
in a 96-well sample plate. For each C18 StageTip, elute using 20 uL of elution buffer (80%
(vol/vol) ACN and 0.1% (vol/vol) TFA).
(ii) Determine the protein abundance of the conformers by proceeding to LC-MS/MS analysis
at Step 14B.

SCX chromatography-based enrichment for cross-linked peptides @ Timing ~2 h per
sample
13 Enrichment is an optional procedure; however, it is generally recommended for protein samples

>100 kDa. This step can be omitted when using fast and sensitive mass spectrometers such as the
Fusion Lumos for the analysis of single proteins and small protein complexes of up to 300-kDa size.
Enrichment can be performed by either StageTip (option A) or HPLC (option B). SCX-StageTip
enrichment is suitable for protein samples <1 MDa, and requires a peptide amount between 5 and
50 pg. SCX base fractionation using an HPLC system is recommended for proteins/protein
complexes >200 kDa and requires a minimum of 100 pg of material.
(A) Enrichment using SCX-StageTip
(i) Elute peptides from C18 StageTips twice with 20 uL of 80% (vol/vol) ACN each time.
A CRITICAL STEP If the C18 StageTip has dried during storage, 1 pL of methanol must be
applied before the 80% (vol/vol) ACN.
(ii) Dilute the peptides (in 80% (vol/vol) ACN) with four times the volume of 2.5% (vol/vol)
acetic acid.
(iii) Load the peptides onto an activated SCX StageTip (Equipment setup).
(iv) Elute the peptides twice with 50 uL of SCX StageTip elution buffer I (containing 50 mM
NH4AcO) each time. Collect the eluate as fraction 1
(v) Elute the peptides twice with 50 uL of SCX StageTip elution buffer II (containing 100 mM
NH4AcO) each time. Collect the eluate as fraction 2
(vi) Elute the peptides twice with 50 uL of SCX StageTip elution buffer III (containing 200 mM
NH4AcO) each time, and collect the eluate as fraction 3.
(vii) Elute the peptides twice with 50 pL of SCX StageTip elution buffer IV (containing 1M
NH4AcO) each time, and collect the eluate as fraction 4.
A CRITICAL STEP Typically, peptides are not equally distributed in the fractions. The
following distribution can be used as a reference for estimating amounts of peptides:
fraction 1 and 2 each contain 30-40% of the total material, fraction 3 contains ~20%, and
fraction 4 contains ~10% of the total. Cross-linked peptides are expected to be enriched in
fractions 2, 3 and 4.
(viii) Dilute the fractions with 300 pL of 0.1% (vol/vol) TFA each and desalt the peptides using
C18 StageTips.
B PAUSE POINT Peptides can be stored on a C18 StageTip at —20°C for multiple months.
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(B) SCX fractionation using HPLC
(i) Elute the peptides from C18 StageTips twice with 20 pL of 80% (vol/vol) ACN each time.

A CRITICAL STEP If the C18 StageTip has dried during storage, 1 pL of methanol must be
applied before the 80% (vol/vol) ACN.

(ii) Reduce the ACN to <20% (vol/vol), using a vacuum centrifuge and then dilute the peptides

with an equal volume of SCX off-line HPLC mobile phase A.

(iii) Separate the peptides on the HPLC system as described in the Equipment setup.

? TROUBLESHOOTING

(iv) Dilute each 200-uL fraction with 200 pL of 0.1% (vol/vol) TFA and desalt the peptides

using C18 StageTips.

A CRITICAL STEP The amount of peptides in each fraction can be estimated based on the
total loading amount and the proportional distribution of the chromatographic peak area
in each fraction.

? TROUBLESHOOTING

B PAUSE POINT Peptides can be stored on a C18 StageTip at —20°C for multiple months.

LC-MS/MS analysis @ Timing 2-3 h per MS acquisition
14 Perform LC/MS analysis of the samples. The digested cross-linked protein sample contains both

cross-linked peptides and non-cross-linked linear peptides. There are two options for LC-MS/MS
analysis. Option A is optimized for the detection of cross-linked peptides. Option B offers better
detection of linear peptides. Choose the latter when determining protein abundance for adjusting
the mixing ratio of cross-linked conformers.
(A) Cross-linked peptides

(i) For fractionated peptide samples from Step 13, elute peptides from C18 StageTips into a

96-well sample plate twice, using 20 uL of 80% (vol/vol) ACN, 0.1% (vol/vol) TFA.
Alternatively, transfer peptides that are already in 80% (vol/vol) ACN, 0.1% (vol/vol) TFA
(i.e., from Step 12A) to a 96-well sample plate.

A CRITICAL STEP 1If the C18 StageTip has dried during storage, 1 pL of methanol must be
applied before the 80% (vol/vol) ACN.

(ii) Remove the solvent using a vacuum concentrator.
(iii) Resuspend the peptides to an ~0.4 ug/pL concentration by adding 0.1% (vol/vol) TFA to

the well.

(iv) Analyze the peptide samples using LC-MS/MS (as described in the Equipment setup).

3.5 uL (1-2 pg) of peptides is injected for each acquisition.

A CRITICAL STEP The amount of peptides injected for MS acquisition is determined on
the basis of the reversed-phase column loading capacity; this may be adjusted when a
different LC setup is applied.

? TROUBLESHOOTING

(B) Non-cross-linked peptides
(i) Remove the solvent from the peptides eluted in Step 12B using a vacuum concentrator.
(ii) Resuspend the peptides by adding 3.5 uL of 0.1% (vol/vol) TFA to the well.
(iii) Analyze the peptide sample using LC-MS/MS as described in the Equipment setup. Note

that z=2+ ions are not excluded for fragmentation. Inject 3.5 pL of the sample for each
acquisition.
? TROUBLESHOOTING

Peptide identification of cross-linked proteins @ Timing 1-24 h per sample

A CRITICAL Identification of cross-linked peptides is not restricted to the pipeline described here. There are
various software tools available for analyzing cross-link data. When considering those, note that use of
isotope-labeled cross-linkers to identify cross-linked peptides complicates the use of isotopes for quantitation.
A CRITICAL Pool MS data from all samples (replicates) for identification of cross-linked peptides.

Convert vendor-specific MS raw data into peak lists

15
16
17

Open software tool msConvert.

Select the file(s) to be converted.

Select the output directory; if not specified, the output file will be placed in the same directory as the
input files by default.
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Table 4 | Parameters for database search for cross-linked peptides using the XiSearch software

Parameter Settings
Enzyme Trypsin
Allowed maximum number of 4

missed cleavages

Cross-linker = BS3 (the reactivity of BS3 is toward the N-terminus of the polypeptide
chain, and lysine, serine, tyrosine and threonine)
* BS3-d4 (the reactivity of BS3-d4 is the same as for BS3)?

Fixed modifications Carbamidomethyl (C)

Variable modifications * Oxidation (M)
= BS3 with the other end amidated or hydrolyzed
= BS3-d4 with the other end amidated or hydrolyzed®

MS tolerance 6 pp.m?

MS2 tolerance 20 p.p.m.®

lons b-ion, y-ion, precursor ion®
Losses -CH3SOH, -H,0, -NH3

°Only applied to quantitation using isotope-labeled cross-linkers.

Determined based on the mass accuracy of the mass analyzer of the mass spectrometer.

“Modify the types of fragment ions accordingly if using fragmentation methods other than collision-induced dissociation or higher-energy collisional
dissociation.

18 Choose ‘mgf as ‘Output format’.

19 If the MS2 spectra were acquired in profile data mode, select ‘Peak Picking’ as a filter. Otherwise,
leave the ‘Filters’ option empty.

20 Start the process by clicking on the ‘Start’ button.
A CRITICAL STEP A detailed tutorial for this process can be found at http://proteowizard.
sourceforge.net/IntroductoryTutorial.shtml.

Prepare protein sequence database for database search
21 Generate a protein database in .fasta format that contains the sequences of the cross-linked
proteins.

Database search for peptide identification using the Xi software

A CRITICAL When setting up XiSearch on a PC with n cores, restrict XiSearch usage to n—1 or fewer

cores, leaving space for performing operation system tasks.

22 Open XiSearch. Select ‘MS peak lists’ (.mgf).

23 Select the .fasta file containing the sequences of the cross-linked proteins.

24 Define the search parameters in ‘config’ as listed in Table 4.

25 Define the directory for search results in ‘Output’. Start the search by selecting ‘Start’; the search
results will be saved in .csv format.
? TROUBLESHOOTING

False discovery rate (FDR) calculation

26 Start the XiFDR’* application and upload the XiSearch search results (in .csv format) as input
under the ‘input’ tab.

27  Set the desired FDR calculation level and FDR value under the ‘FDR Settings’ tab. The following
settings are recommended:

Select ‘Simple FDR’ mode, set ‘FDR’ = 5 (%) at ‘Links’ level, and tick the ‘Boost result’™* option.
Leave the other parameters in the default settings.

28 Start FDR calculation by selecting ‘Calculate’.

29 Export the FDR calculation results in either.csv or .tsv format under the ‘Results’ tab ‘CSV/TSV’
option. Both results formats can be viewed and further processed using spreadsheet applications
such as Microsoft Excel.

30 XiFDR generates an output folder for each FDR calculation, reporting identified cross-linked
peptides (option A) and non-cross-linked linear peptides (option B).
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(A) Use of cross-linked peptides
(i) Use the list of peptide spectrum matches of identified cross-linked peptides (the *_PSM_*’
file) for generating input data (a .SSIfil§) for quantifying signals of cross-linked peptides
using Skyline. Proceed to Step 31.
? TROUBLESHOOTING
(B) Use of non-cross-linked linear peptides
(i) Use the list of peptide spectrum matches of identified linear peptides (the *_Linear_
PSM_* file) for generating input data (a .ssl file) for protein abundance quantitation using
Skyline. Proceed to Step 52.

MS1-based quantitation of cross-linked peptides using Skyline @ Timing 60-80 cross-
linked peptides per hour

Prepare input data files

31

32

33

Convert vendor-specific MS raw data generated at Step 14(A) into the mzML format using
MSConvert as described in Steps 15-21; however, select ‘mzML’ for ‘Output format’ and leave the
‘Filters’ option empty.

Linearize the sequences of identified cross-linked peptide as demonstrated in Fig. 2. For a cross-
linked peptide pair, peptide A and peptide B, the linearized sequence consists of the sequence of
peptide A followed by a connector and then the sequence of peptide B. A modification with user-
defined mass is added to each cross-linked residue to indicate cross-linking sites. The connector is a
modified amino acid. Users can choose their preferred residue as connector, and the modification is
calculated so that the mass of the linearized sequence is identical to that of the original cross-linked
peptide. Linearization of cross-linked peptide sequence can be automated using a combination of
built-in functions in Microsoft Excel (examples are shown in Supplementary Table 2).

Convert modifications in the linearized sequences of cross-linked peptides into Skyline format
(Fig. 2¢). A list of identified features of cross-linked peptides in the standard .ssl format
(https://skyline.ms/wiki/home/software/BiblioSpec/page.view?name=BiblioSpec%20input%20and
%200utput%20file%20formats) can be generated using Microsoft Excel. Save this list as a text (tab-
delimited) file, and rename the *.txt file as *.ssl in File Explorer. For quantitation using isotope-
labeled cross-linkers, generate a separate .ssl file containing the pseudo identification information of
the cross-linked peptide features.

A CRITICAL STEP Our strategy for generating pseudo identification requires co-elution of the light
and the heavy versions of cross-linked peptides in the reversed-phase chromatography in the
LC-MS system. Although deuterium labeling led to a shift in elution retention time, we observed
that elution windows of BS3 and BS3-d4 cross-linked peptides largely overlap (Supplementary
Fig. 2). However cross-linkers labeled with more deuterium atoms may lead to non-overlapping
elution windows of the heavy-labeled and the non-labeled versions of cross-linked peptides.

A CRITICAL STEP Keep the .ssl files in the same folder/directory as the corresponding mzML files.

Define modifications and set parameters in Skyline

34

35

36

37
38

Start Skyline and open a new file.
Select modifications that are predefined in Skyline (Supplementary Fig. 4) by selecting ‘Settings’ >
‘Peptide settings’ > ‘Modifications’. Select modifications such as ‘Carboxymethyl (C) and
‘Oxidation (M)’ from the dropdown list.
A CRITICAL STEP In Skyline versions before 3.7, pre-defined oxidation of methionine is by default
not defined as a variable modification, and needs to be changed manually.
Define customized modifications as follows.

Select ‘Settings’ > ‘Peptide settings’ > ‘Modifications’ > ‘Edit list *> ‘Add ’.

Table 5 lists the modifications defined for BS3 cross-linking.
Set ‘Max variable mods’ according to the input data.
Set the parameters that are relevant to MS1 full-scan filtering (Table 6, Supplementary Fig. 5).

Quantify MS1 signal of cross-linked peptides

39

Build a peptide library (Supplementary Fig. 6) as follows.
Select ‘Settings’ > ‘Peptide settings’ > ‘Library’ > ‘Build’.
Select the .ssl files as ‘input files’.
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Table 5 | User-defined modifications in Skyline for quantifying BS3 cross-linked peptides

Modification Chemical formula Amino acid Variable modifications Calculated mass
by Skyline
Mod:BS3-OH(KSTY) H12Cs03 K,S,TY Yes 156.078644
Mod:BS3-NH2(KSTY) Hi3CgO,N K,S,TY Yes 155.094629
Mod:BS3d4-OH(KSTY)? HgCgO3D4 K,S,TY Yes 160.103751
Mod:BS3d4-NH2 HoCgOoND4 K,S,T,Y Yes 159.119736
(KSTY)?
LinkSite(KSTY) H KSTY Yes 1.007828
Xlink:BS3-link C,H3-N E Yes 25.020401
Xlink:BS3d4-link® C,D4-NH E Yes 29.040508

“Modification is defined and applied only when quantifying using isotope labeled cross-linkers.

Table 6 | Skyline parameters that should be set for MS1 full scan filtering

Peptide filters ‘Settings' > 'Peptide settings’ > 'Filter’
‘Min length’/'Max length’ should be set accordingly to include all identified peptides
that need to be quantified in the peptide library

Transition full scan ‘Settings' > ‘Transition settings’ > ‘Full scan’

parameters = ‘Isotope peak included’ = Count
* '‘Peaks’ = number of isotope peaks used for quantitation. Comment: At least three
isotope peaks are recommended for use in quantitation. However, this number should
be less than the mass difference between the light and the heavy version of a cross-
linked peptide when isotope labeled cross-linkers are applied for quantitation
* ‘Precursor mass analyzer' = Orbitrap (in our LC-MS setup)
= ‘Resolving power’ = resolution applied for acquiring MS1 spectra Comment: Precursor
mass analyzer and Resolving power should be defined based on the mass spectrometer
and acquisition method used
« ‘Retention time filtering’, select ‘use only scans within (X) minutes of MS/MS IDs'.
Comment: The default time window is 5 min; however, it can be customized

Transition filter ‘Settings' > ‘Transition settings’ > ‘Filter'
= ‘Precursor charge' should include all identified charge states of cross-linked peptides in
the input
= ‘lon type’ = p (for precursor)

A CRITICAL STEP A separate library should be built for pseudo identifications of cross-linked
peptide features when using isotope-labeled cross-linkers for quantitation.
40  Select spectra libraries for quantitation as follows.
Select ‘Settings’ > ‘Peptide settings’ > ‘Library’ > ‘Libraries’.
Select all spectra libraries that should be used for quantitation for a given dataset from the list.
Select ‘Pick peptide matching library’ .
41 Add peptides in the libraries to the list for quantitation (calculating transitions for quantitation).
Select ‘View’ > ‘spectra libraries’.
View spectra libraries in the Spectra Library Explorer and then select ‘Add all’ to add all peptides
in the library to the target list for quantitation. Based on the transition parameters set in Step 38,
transitions are calculated for each cross-linked peptide.
A CRITICAL STEP If the input data consist of multiple libraries (e.g., a separate library is built for
pseudo identifications of cross-linked peptide features when using isotope-labeled cross-linkers),
after adding peptides from one library, switch the view to another library using the dropdown menu
and add peptides. Repeat the process until peptides in all libraries are added.
? TROUBLESHOOTING
42 TImport MS raw data for quantitation as follows.
‘File’ > ‘import’ > ‘results’.
Upload the data in .mzML format.
A CRITICAL STEP For label-free quantitation, MS data for all conformers (including replicates)
should be uploaded and quantified together. Similarly, when quantifying using isotope-labeled
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Table 7 | Required data columns in Skyline result report

Data column Location in the ‘Columns’ menu

Peptide Modified Sequence ‘Proteins’ > ‘Peptides’

Replicate Name ‘Replicates’

Normalized Area ‘Proteins’ > ‘Peptides’ > 'Peptide results’ > ‘Quantitation’

cross-linkers or SILAC, MS data from the forward-labeled and the reverse-labeled experiments
should be uploaded and quantified together.

Quality control of automated quantitation results

A CRITICAL As with any other software, errors do exist in the automated quantitation results from
Skyline; these mainly result from incorrectly isolated MS1 signals. This happens more often with low-
intensity signals. Manually inspecting and correcting the isolated peptide signals for quantitation can
dramatically improve the accuracy of quantitation results. In a typical example, it takes <20 s to correct
the isolation windows of quantified cross-linked peptides.

43

44

45

46

47

48

49
50

51

Display the chromatogram of all quantified samples in a tiled view (each MS acquisition in a
separate window) by entering: View>Arrange Graphics>Tiled.

Click on one cross-linked peptide in the ‘targets’ list to display the extracted chromatography of this
peptide in each MS acquisition.

Right-click on one chromatogram; under the ‘peptide ID times’ option, select ‘matching’ and
‘aligned’ to display the retention times of identified MS2 events and/or aligned identification of this
peptide in each MS acquisition.

Select ‘View’ > ‘Peak areas’ > ‘Replicate comparison’.

The abundance of the isolated MS1 signals of the selected cross-linked peptide in each MS
acquisition are shown in a bar chart with isotope dot products labeled (in a new window). The
isotope dot product compares the intensities of isolated isotope peak signals against the theoretical
isotope abundance distribution calculated based on peptide sequence. A dot product value can
range between 0 and 1, and 1 indicates a perfect match.

Inspect the isolated peptide signal according to the following criteria (Supplementary Fig. 7): (i) if
the isolation window of a peptide includes the whole elution peak of the peptide, (ii) if the isolated
elution window agrees with the retention time (RT) of identified MS2 events or aligned
identification RT, (iii) if the isotope dot product value is 20.9, (iv) if the isotope dot product value is
<0.9; examine the MS1 spectrum of the selected peptide by clicking on the elution peak in the
chromatogram (a new window will appear with MSI spectrum).

If the signal isolation window is incorrect, correct it by manually adjusting the window’s
boundaries.

Move to the next cross-linked peptide until you have examined all peptides in the ‘target’ list.
Customize the contents (data columns) of the quantitation results report.

Select ‘View’ > ‘Document Grid’ > ‘Views’ > ‘Edit view’.

All options for the data columns are listed in the menu under the ‘Columns’ tab. Tick selected
data columns to include them in the report. Table 7 lists the data columns that are required.
Export the report for quantitation results.

Select ‘File’ > ‘Export’ > ‘Report’.

The reports are in .csv format. Proceed to Step 64.

Quantification of protein abundance @ Timing ~1d
Quantify the MS1 signal of linear peptides using Skyline

52
53

54

55

Convert the vendor MS raw data generated into the mzML format using MSConvert.

Open the list of identified non-cross-linked linear peptides (the *_Linear_PSM_*’ file generated in
Step 30B(i)) using Microsoft Excel.

Remove the peptides that contain methionine residue(s) or contain any other variable modifications
such as hydrolyzed or amidated cross-linkers.

Generate a .ssl file containing the identified MS2 features of the filtered linear peptide list by
following the instructions in Step 33.
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194

56

Quantify these linear peptides based on their MS1 signal by following the instructions in
Steps 34-51.

Quantification of protein abundance

A CRITICAL Steps 57-61 should be conducted for the forward-labeled and the reverse-labeled replicates,
i.e., comparing each pair of conformers separately: BS3 cross-linked conformer I versus BS3-d4
cross-linked conformer II, and BS3-d4 cross-linked conformer I versus BS3 cross-linked conformer II.

57

58
59

60

61

Open the Skyline quantitation report generated in Step 56 in Microsoft Excel (or another
spreadsheet application).

Discard peptides that are not quantified in both conformers.

Calculate conformer II/conformer I signal intensity ratio for each peptide. Peptide signal intensity is
reported as ‘Normalized Area’.

Define the abundance of conformer I as 1, the relative abundance of conformer II is calculated as
the median of the conformer II/conformer I signal intensity ratios of all peptides.

For protein complexes, calculate the relative abundance of conformer II for each subunit separately.
Discard subunits that are quantified with fewer than five peptides. The median value of all
quantified subunits is then defined as the relative protein abundance of conformer II for the
protein complex.

Mix conformers 1:1 for quantitation using isotope-labeled cross-linkers

62

63

Based on the quantified relative abundance of conformers I and II, mix BS3 cross-linked conformer
I and BS3-d4 cross-linked conformer II with an equal protein amount after eluting the peptides
from C18 StageTips (as described in Step 12A(i)). Do the same with the reverse-labeling replicates.
A CRITICAL STEP When conformers I and II have the same protein composition (i.e., identical
sequence, same subunits), either a 1:1 mass ratio or a 1:1 molar ratio can be used for mixing. When
the two conformers have different protein compositions (i.e., contain different numbers of
subunits), they should be mixed with equal molar ratio.

Carry on with isotope-labeling-based quantitation for cross-linked peptides by proceeding to Step
13 or 14A.

Summarizing quantitation results of cross-linked peptides ® Timing 1-2 d

64

Follow the steps in option A if you are working with isotope-labeled cross-linkers, use option B if
you are using non-isotope-labeled cross-linkers.
(A) Quantitation using isotope-labeled cross-linkers

(i) Open the Skyline quantitation report using Microsoft Excel (or another spreadsheet
application)

(ii) Summarize the data from the forward-labeled and the reverse-labeled replicates separately.

(iii) Based on the light and heavy signals of each cross-linked peptide, divide the quantified
cross-linked peptides into two groups. When either the light or the heavy signal intensity of
a cross-linked peptide is zero, this cross-linked peptide is defined as a ‘singlet’. Both the
light and the heavy signal intensities are not zero for a ‘doublet’ cross-linked peptide.

(iv) Calculate the conformer I/conformer II signal ratio for doublet cross-linked peptides. If a
cross-linked peptide is quantified in more than one SCX fraction, sum the signal ratios by
taking the median value.

(v) Define singlet cross-linked peptides as ‘conformer I-unique’ or ‘conformer II-unique’
according to the signal detected. For example, in the forward-labeled replicate, a singlet
cross-linked peptide observed with the light signal is conformer I-unique.

(vi) Define a cross-link (a cross-linked residue pair) as ‘conformer I-unique’ if all its supporting
cross-linked peptides are conformer I-unique. A similar rule applies to ‘conformer II-unique’
cross-links. Otherwise cross-links are defined as ‘doublet’, and the conformer I/conformer II
signal ratios are calculated as the median of all their supporting cross-linked peptides.

(vii) Combine data from the forward-labeled and the reverse-labeled replicates and discard cross-
links that quantified in only one replicate.

(viii) Verify quantitation results of cross-linked peptides that are quantified in both replicates.
Conformer I-unique or conformer II-unique cross-links should be consistently quantified in
both replicates. Calculate the conformer I/conformer II signal ratios for cross-links that are
quantified as ‘doublet’ in both replicates as the mean of the replicates.

NATURE PROTOCOLS | VOL 14 | JANUARY 2019 |171-201 | www.nature.com/nprot


www.nature.com/nprot

NATURE PROTOCOLS PROTOCOL

Troubleshooting

(ix)

A CRITICAL STEP A cross-link quantified as a heavy singlet can be quantified as a doublet in
the replicate with a permutated isotope-labeling scheme as a consequence of overlapped light
and heavy signals (Supplementary Fig. 8). In such cases, carry out manual validation by
viewing the MSI signal using Skyline or vendor-specific browsers.

? TROUBLESHOOTING

Apply only cross-links with verified quantitation results for further structural interpretation.
A CRITICAL STEP Conformer I-unique and conformer Il-unique cross-links represent
conformational differences. Conformational difference can also be reflected as major signal
changes between the two conformers. By contrast, cross-links derived from the regions that
have the same structural features in the two conformers give rise to a conformer I/conformer
IT signal close to 1; this should be the case for most quantified cross-links.

A CRITICAL STEP Solely by number, it is unclear if a conformer I/conformer II signal ratio
indicates conformational difference or just reflects general data spread that is unrelated to
protein conformations. Some studies drew a conclusion based on arbitrary cutoffs. In our
benchmark study, we applied the statistics tool Perseus (http://www.coxdocs.org/doku.php?
id=perseus:start) to model the distribution of log,(conformer I/conformer II) values of cross-
links, and defined the cutoff for significant values. The significant changes on cross-link
signals coincide with conformational changes revealed by comparing available crystal
structures of the two conformers’.

? TROUBLESHOOTING

(A) Label-free quantitation

@)
(i)
(iif)
(iv)
v)
(vi)

(vii)

(viii)

Open the Skyline quantitation report using Microsoft Excel (or another spreadsheet
application)

For a cross-linked peptide that is quantified in more than one SCX fraction, sum up the
signal intensities (‘Normalized Area’) measured in all fractions within each replicate.

For each cross-linked peptide, its signal intensity in each conformer is calculated as the
median signal intensity of the three replicates.

Quantify the relative protein abundance of each conformer by following the instructions in
Steps 52-61 and using the *_Linear_PSM_*’ file from Step 30B.

Use the relative protein abundances as normalization factors to normalize the signal
intensities of the cross-linked peptides in conformers.

Choose the conformer with greatest number of cross-linked peptides quantified as
reference, and then calculate the relative signal intensities (normalized, if not specified
otherwise) of cross-linked peptides with respect to the reference.

Summarize the relative signal intensities of cross-linked residue pairs as the median of
relative signal intensities of all their supporting cross-linked peptides.

Compare the relative signal intensities of cross-linked residue pairs between conformers to
draw conclusions about the structural similarities and differences between conformers.

? TROUBLESHOOTING

Troubleshooting advice can be found in Table 8.

Table 8 | Troubleshooting table

Step Problem Possible reason Solution
9 No or low yield of cross-linking products,  Cross-linking sample buffer contains Avoid using even trace amounts of buffer
even when using high cross-linker components that interfere with cross- components that interfere with cross-
concentrations linking reaction linking, such as amine salts and Tris
Low activity of the cross-linker Use BS3 from a freshly opened vial and

prepare fresh cross-linker solution
immediately before use

First, check that neither of the first two
reasons applies. You should see the bands

Table continued
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Table 8 (continued)

Step Problem Possible reason Solution
Proteins do not have a pair of reactive of the individual proteins become fuzzy.
side chains in the right geometry toward Use a cross-linker of different reactivity or
each other longer spacer length
The optimal protein/cross-linker ratios Conformational differences lead to A ratio that gives similar and reasonable
are different for two conformers of a different cross-linking kinetics yields of the desired cross-linking product
protein-protein complex for both conformers should be applied
10A(v) &  Yields of cross-linking products are Cross-linker solution is not sufficiently Vortex briefly or mix well by pipetting.
10B(v) lower than those of the titration mixed with the protein sample Avoid foaming
experiment using the same protein/
cross-linker ratio under the identical
reaction conditions
1A (xviii) When loading peptides on a C18 StageTip, Incomplete digestion due to incomplete  Use freshly made DTT solution for
& 11B(viii)  the StageTip has dramatically increased reduction/alkylation reduction, avoiding hydrolysis of DTT
back-pressure, and hgrdly EInky liquid Incomplete digestion due to insufficient  In Step 11A(viii), increase the amount of
passes thrpggh the tip (hax{lng excluded protease trypsin up to a protein/enzyme mass ratio
the possibility of small particles or gel of 20°1
pieces clogging the StageTip) In Step 11B(vi), increase the concentration
of LysC and trypsin; however, do not
exceed a 20:1 protein/enzyme mass ratio.
Avoid buffer components that inhibit the
activity of LysC or/and trypsin
13B(iii), Low signal intensity in the chromatogram  Incomplete digestion, often as a result of ~ See solutions for Step 1TA(xviii) and11B
14AG3v) & highly charged material being eluted at  (viii)
14B(iii) the end of the LC gradient
Peptide material loss on StageTips Activate StageTips properly before loading
and also for elution if they have dried,
following the instructions in the protocol
and the Equipment setup, and do not
overload the StageTips; if necessary use
more than one StageTip
Faulty instruments (such as faulty Perform instrument maintenance
injection of autosampler, leak in LC
system, poor ionization, space charging
within the mass spectrometer)
14A(iv) &  Contaminating polymer signals Detergents (such as NP40 and Triton X-  Strictly avoid such detergents in the cross-
14B(iii) 100) are present in the cross-linked link buffer if followed by in-solution
sample digestion, or clean up the cross-linked
protein sample using SDS-PAGE and follow
with in-gel digestion
Contaminated LC solvent (e.g., by Replace the solvent and avoid
polymeric pipette tips) contamination
25 Running XiSearch search dramatically Available physical memory is less than Assign reasonable memory resources
slows down the performance of the PC assigned memory for XiSearch; when setting up XiSearch; ensure enough
device computation is running on hard drives physical memory is available for running
database search
30A®%) No or few cross-linked peptides identified Limited sensitivity and speed of the mass  Inject more material for LC-MS (without
(when there is no problem in previous spectrometer overloading the system).
procedures) Apply SCX-based enrichment, if not done
earlier.
Apply more elaborate SCX fractionation
with more starting material.
Analyze the sample using faster and more
sensitive mass spectrometers
Incorrect database search parameters Adjust search parameters according to
applied instrument specifications and parameters
applied for acquisition
41 A few peptides in the peptide library The peptide does not match the current  Adjust filter settings or correct
cannot be added to the ‘target’ list for settings for modifications or filters modification definitions
quantitation
Chromatography peaks of the majority of DDA acquisition cycle is too long In the acquisition method, set a shorter
cross-linked peptides are defined by fewer cycle time or reduce the number of MS2
than 5 MS data points events per acquisition cycle
Table continued
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Table 8 (continued)

Step Problem Possible reason Solution
64A(viii) The distribution of conformer |/conformer  The reactivities of BS3 and BS3-d4 are Store cross-linkers correctly according to
2 signal ratio of cross-links is not centered  different the manufacturer’s instructions, use BS3
at 1 (although conformers are mixed with and BS3-d4 from freshly opened vials and
equal protein amounts) prepare fresh cross-linker solution for both
BS3 and BS3-d4 immediately before cross-
linking reaction
Conflicting quantitation results between
replicates with a permutated isotope-
labeling scheme
= Results show a ‘singlet’ in one replicate  Overlapping signals of the isotope Manually inspect the MS1 signals and
and a ‘doublet’ in the one with a clusters of the light and the heavy correct the quantitation results
permutated isotope-labeling scheme versions of the peptides
= Conformer I-unique in one replicate and  False identification of the cross-linked Discard the cross-linked peptide
conformer ll-unique in the replicate with a  peptide
permutated isotope-labeling scheme
64A(ix) &  Quantified cross-links do not reveal any Cross-links derived from the regions Improve the identification of the cross-
64B(viii) conformational differences with conformational differences are not  linked peptides
identified and quantified
No cross-links form in the regions with ~ Apply different cross-linking chemistry for
conformational differences with QCLMS analysis
currently applied cross-linking chemistry
Timing

Anticipated results

Typically, a complete analysis takes 1-3 weeks, as detailed below.

Steps 1-9, pre-experiment: ~8 h

Step 10, quantitative cross-linking for either option A or option B: 6-8 h (including SDS-PAGE) or 1-3
h (without SDS-PAGE)

Steps 11 and 12, trypsin digestion for either option A or option B: ~20 h, including overnight incubation
Step 13, SCX enrichment of cross-linked peptides for either option A or option B: ~2 h per sample
Step 14, LC-MS/MS analysis for either option A or option B: 2- to 3-h per MS acquisition

Steps 15-30, peptide identification: 1-24 h per sample, depending on the number of MS/MS spectra,
database size and computational power

Steps 31-51, quantitation of cross-linked peptides using Skyline: 60-80 cross-linker peptides per h
Steps 52-63, quantification of protein abundance: ~1 d

Step 64, summarizing quantitation results: 1-2 d

To compare the structure of the 26S proteasome Lid complex (12 subunits) with its last assembly
intermediate, LP2 (ref. '*), we cross-linked Lid complex using BS3 and cross-linked LP2 using BS3-
d4. The monomeric cross-linked complexes were isolated using SDS-PAGE and digested in-gel by
trypsin. LP2 has one subunit less than the Lid complex. The peptides from LP2 and Lid were mixed in
a 1:1 ratio according to the protein abundances (measured by mass spectrometry) of 11 shared
subunits. Before LC-MS/MS analysis, cross-linked peptides were fractionated and enriched by SCX
chromatography using an HPLC system. LC-MS/MS was conducted using a Q Exactive mass spec-
trometer. Cross-linked peptides were identified and quantified. The analysis was repeated with a
reverse isotope-labeling scheme. In total, 81 cross-links were quantified in both replicates (Fig. 3a).
Using the proteomics statistics tool Perseus, we defined (with P < 0.05) 16 cross-links that are
significantly enriched in either Lid or LP2. Together with one Lid-unique and three LP2-unique
cross-links, they indicated conformational differences between Lid and LP2. The locations of these
cross-links pointed out the regions in Lid that have been rearranged from LP2 upon the binding of
the final subunit (Fig. 3b).

Here, we also exemplify our label-free quantitation workflow. Cross-linking human complement
factor H (FH) using BS3 gave rise to two monomeric cross-linking products that can be resolved
using SDS-PAGE. Comparing these two cross-linking products using QCLMS revealed an open and a
closed conformation of the protein in solution'” (Fig. 3c). We also applied our label-free quantitation
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Fig. 3 | Applications of QCLMS workflows. a, The quantified ‘LP2/lid" signal ratios of 81 cross-links in the analysis comparing the 26S proteasome Lid
and its assembly intermediate, lid particle 2 (LP2). b, Cross-links that are unique or enriched in either Lid or LP2 highlight the region in the Lid structure
that is rearranged from LP2 to the Lid. ¢, Label-free quantitation of two monomeric cross-linking products of human factor H (HF) revealed open and
closed conformations of the protein. d, The relative intensities of cross-links from TAF13 to TAF11 region A and TAF11 region B. The signal intensity of
the cross-link between TAF13 and TAF11 region A is reduced in the presence of human TATA-box binding protein (TBP). e, The relative intensities of
individual quantified cross-linked peptides supporting cross-links from TAF13 to TAF11 region A and TAF11 region B. The signal intensities of all
supporting cross-linked peptides of the cross-link between TAF13 and TAF11 region A are reduced in the presence of TBP. a,b adapted from ref. =°
under a Creative Commons Attribution 4.0 license (https://creativecommons.org/licenses/by/4.0/legalcode). ¢ adapted from ref. *° under a
Creative Commons Attribution 3.0 license (https://creativecommons.org/licenses/by/3.0/legalcode). d,e adapted from ref. ks Springer Nature.

workflow to study whether and how the conformation of the TAF11-TAF13 heterodimer changes
when interacting with a third protein, TBP'”. We quantified yield changes on cross-links between
TAF11 and TAF13 with and without binding by TBP. These cross-links are between TAF11 residues
and a photoactivatable amino acid analog (diazirine-lysine; DiAzKs) that has been incorporated into
the TAF13 sequence, substituting residue K34. In two replicated analyses (experiment was repeated
from the point of protein purification), we repeatedly detected two regions in TAF11 that cross-link
with the TAF13 DiAzKs™* (Fig. 3d). Upon TBP binding, cross-links with TAFI11 region A
exhibited over two-fold signal reduction on all supporting cross-linked peptides (Fig. 3e). By contrast,
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cross-links to TAF 11 region B showed similar yield with and without the presence of TBP.
Mann-Whitney U test results further confirmed that in the presence of TBP, the yields of TAF13
DiAzKs™ cross-links to TAF11 region A are significantly affected, whereas cross-links to TAF11
region B remain largely unaffected. These results suggest that TAF11 region A might be involved in
the interaction between TAF11-TAF13 and TBP.
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